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Document History

Caution

Before you start the implementation, make sure you have the latest version of this document. You can find the
latest version at the following location: service.sap.com/instguides.

The following table provides an overview of the most important document changes.
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1 Getting Started

Caution

This guide does not replace the daily operations handbook that we recommend customers to create for their
specific production operations.

About this Guide
Designing, implementing, and running your SAP applications at peak performance 24 hours a day has never been
more vital for your business success than now.

This guide provides a starting point for managing your SAP applications and maintaining and running them
optimally. It contains specific information for various tasks and lists the tools that you can use to implement them.
This guide also provides references to the documentation required for these tasks, so you will sometimes also
need other guides such as the Installation Guide, Security Guide, and SAP Library.

Global Definitions

SAP Application

A SAP application is an SAP software solution that serves a specific business area like ERP, CRM, PLM, SRM, and
SCM.

Business Scenario

From a microeconomic perspective, a business scenario is a cycle, which consists of several different
interconnected logical processes in time. Typically, a business scenario includes several company departments
and involves with other business partners. From a technical point of view, a business scenario needs at least one
SAP application (SAP ERP, SAP SCM, or others) for each cycle and possibly other third-party systems. A business
scenario is a unit which can be implemented separately and reflects the customer’s prospective course of
business.

Component

A component is the smallest individual unit considered within the Solution Development Lifecycle; components
are separately produced, delivered, installed and maintained.

Important SAP Notes

Caution

Check regularly for updates available for the Application Operations Guide.

Tablel
1719282 POS TLOG Table Partitioning Note describing partitioning of the /
Information POSDW/TLOGF table.
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2 Technical System Landscape

The following diagram provides an overview of SAP Customer Activity Repository, illustrating the different
components of the repository, optional data replication, as well as the integration with consuming and receiving
applications.
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Figure 1: SAP Customer Activity Repository

Related Documentation

The following table lists where you can find more information about the technical system landscape.

Table 2
Guide/Tool Quick Link on the SAP Service Topics
Marketplace (service.sap.com)
Master Guide |p service.sap.com/instguides » ®  Application- and Industry-specific
Industry Solutions ¥ Industry Solution Components such as SAP
Guides » SAP for Retail » SAP Financials and SAP Retail
Customer Activity Repository » SAP e  Technology Components such as
Customer Activity Repository 2.0 » SAP Web Application Server
Common Master Guide 1 ®  Technical Configuration
®  Scalability
e High Availability
CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company. SAP Customer Activity Repository 2.0 SPO1

6 All rights reserved. Technical System Land



http://service.sap.com/instguides

Guide/Tool Quick Link on the SAP Service Topics
Marketplace (service.sap.com)

Quick Sizer Tool | service.sap.com/sizing » Sizing Sizing
Guidelines » Industries » SAP Customer
Activity Repository 2.0 3

Security Guide | service.sap.com/security » SAP Security

Security Guides » Industry Solutions ¥
SAP for Retail » SAP Customer Activity
Repository » Security Guide - SAP
Customer Activity Repository 2.0 2

Administrator’'s Guide

|# service.sap.com/instguides »
Industry Solutions » Industry Solution
Guides » SAP for Retail » SAP
Customer Activity Repository » SAP
Customer Activity Repository 2.0
Administrator's Guide, Demand Data
Foundation (DDF) 2.0 with Unified
Demand Forecast (UDF) on SAP
HANA 3.

Information about the Demand Data
Foundation component of the SAP
Customer Activity Repository

SAP Customer Activity Repository 2.0 SPO1
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3  Monitoring of SAP Customer Activity
Repository

Within the management of SAP Technology, monitoring is an essential task. A section has therefore been devoted
solely to this subject.

You can find more information about the underlying technology in the SAP NetWeaver Administrator's Guide -
Technical Operations Manual in the SAP Library under SAP NetWeaver Library.

3.1 Alert Monitoring

Proactive, automated monitoring is the basis for ensuring reliable operations for your SAP system environment.
SAP provides you with the infrastructure and recommendations needed to set up your alert monitoring to
recognize critical situations for SAP Customer Activity Repository as quickly as possible.

1 Note

Component-specific monitoring via CCMS is not supported for software components RTLCAR 200 and
RTLPOSDM 300. Alternative monitoring possibilities are described below.

Monitoring of SAP HANA
You can monitor SAP HANA through SAP HANA Studio or SAP Solution Manager.

SAP HANA Studio

The System Monitor in SAP HANA Studio provides an overview of SAP HANA systems with information such as
the operational state, alerts generated, disk size for data, log and trace, memory used, percentage of CPU being
used, and so on. For more detailed monitoring of resource usage and performance for a particular SAP HANA
system, please use the Administrator Editor.

For information about the installation and general monitoring and administration of SAP HANA, and about the use
of SAP Solution Manager with SAP HANA Studio, see the Administrator's Guide, SAP HANA Live for SAP Business
Suite on SAP Help Portal at help.sap.com/hba Master, Installation, Security, Configuration, and Operations
Information.

For more information about monitoring SAP HANA systems using SAP HANA Studio, see the SAP HANA
Administration Guide on SAP Help Portal at |» help.sap.com/hana_appliance » System Administration and
Maintenance Information » SAP HANA Administration Guides » SAP HANA Administration Guide 3.

SAP Solution Manager

SAP Solution Manager can also be used for basic administration and monitoring of SAP HANA systems within
SAP landscapes. SAP HANA integrates into existing operations with little effort if SAP Solution Manager is already
in use. It is highly recommended to use SAP Solution Manager Release 7.1 SPO5 or higher in order to get optimal
support for SAP HANA. The monitoring and alerting infrastructure of SAP Solution Manager is based on central
agent infrastructure. Pre-configured agents for SAP HANA are delivered by SAP. Once the agents are deployed on
SAP HANA and connected to SAP Solution Manager, SAP Solution Manager will receive all alerts of the HANA
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Studio. For larger and more complex landscape scenarios, SAP Landscape and Virtualization Manager (LVM)
integrates with SAP HANA to allow basic operations like starting and stopping as well as management of
dependencies.

For more information about connecting SAP Solution Manager to SAP HANA, see the SAP HANA Technical
Operations Manual on SAP Help Portal for SAP HANA Appliance Software at help.sap.com/hana_appliance

IF System Administration and Maintenance Information » SAP HANA Technical Operations Manual 3.See also SAP
Service Marketplace at service.sap.com/solman-hana.

For more information about SAP Solution Manager, see SAP Help Portal for Solution Manager at help.sap.com/
solutionmanager.

Monitoring of SAP Customer Activity Repository

Monitoring for the POS Data Management component in SAP Customer Activity Repository consists of the
following:

e POS DM Application Log

e POS DM Message Log

e  Auditor Report

® Trace and Log files (accessed using transaction s1.G1 to log and trance ABAP components)

Monitoring of the SAP Landscape Transformation Replication Server

If you are replicating data from other source systems, monitoring of the SAP Landscape Transformation (LT)
Replication Server is essential to ensure data consistency between the source system (for example, SAP ERP)
and SAP Customer Activity Repository. The Configuration and Monitoring Dashboard (transaction LTR in the SLT
server) provides users with information that can be used to monitor and identify potential replication issues. The
overview screen provides the overall status of the configurations. For each configuration, detailed information is
provided, which includes statuses of jobs and connections, statuses of database triggers for tables selected for
replication, and statistical information about tables and settings.

As of release DMIS_2010 SPO7 on the SAP LT Replication Server, you can use system monitoring capabilities of
SAP Solution Manager 7.1 (SPO5 or higher) to monitor the status of a configuration and its related schema.

For more information about monitoring load and replication process, see the Application Operations Guide,
Trigger-Based Data Replication Using SAP Landscape Transformation Replication Server on SAP Help Portal at
help.sap.com/hana_appliance |» System Administration and Maintenance Information » SAP LT for SAP HANA
Technical Operations Manual 3.

3.2 Detailed Monitoring and Tools for Problem and
Performance Analysis

The following functions are available within SAP Customer Activity Repository to monitor data flow within the
application:

® /POSDW/LOGS — POS Data Management Application Log

® /POSDW/DISPLAY MESSAGELOG — POS Data Management Message Log

® /POSDW/DISPLAY MODIFICATIONS - Auditor Report

POS Data Management Application Log

The POS Data Management Application Log collects messages, exceptions, and errors, and displays them in a log.
This log provides you with basic header information, a message long text, detailed information, and technical
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information. For more information, see SAP Help Portal for SAP NetWeaver at help.sap.com/nw. Choose a
release. Under Application Help, choose |+ Function-Oriented View » SAP NetWeaver Library: Function-Oriented
View » Application Server ABAP » Other Services » Services for Business Users » Application Log - User Guidelines

(BC-SRV-BAL) 3.

POS Data Management Message Log

The POS Data Management Message Log displays message logs by store and by posting date. You can filter the
report by message-related criteria, such as message class or message priority.

Auditor Report

You use the Auditor Report to track manual changes made to POS transactions, as well as to get information
about the origin of the transactions, such as the POS Workbench, an IDoc, or a remote function call module.

Trace and Log Files

Trace files and log files are essential for analyzing problems. Transaction S1.G1 is used to log and trace ABAP
components. An Application Log consists of a log header and a set of messages. The log header contains general
data, such as type, created by/on, and so on. Each log in the database also includes the attributes Object and
Subobject. These attributes are used to describe and classify the application that has written the log.

Table 3: Important Log and Trace Files of POS Data Management (RTLPOSDM) Component

Object Subobject

/POSDW/PIPE CHANGE TASKSTATUS Task status change

/POSDW/PIPE CREATETREX TREX index generation

/POSDW/PIPE CREDITCARD MIGRATION Migration of encryption of credit card
numbers

/POSDW/PIPE DELETE Delete program

/POSDW/PIPE DELETE AGGREGATE Deletion program for POS aggregates

/POSDW/PIPE IDOCDISPATCHER IDoc dispatcher

/POSDW/PIPE INBOUND DISPATCHER Initial processing using queue

/POSDW/PIPE OUTBOUND_ DISPATCHER Outbound processing for POS
aggregates

/POSDW/PIPE PIPEDISPATCHER POS dispatcher

/POSDW/PIPE REFRESH INDEX Reconstruction of transaction index

/POSDW/PIPE REORG_TIBQ Reorganization of TIBQ

/POSDW/PIPE STOREDAYCHANGE POS Data Key change

/POSDW/PIPE XML IN Import POS Transactions as XML file

/POSDW/PIPE XML OUT Export POS Transactions as XML file
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Table 4: Important Log and Trace Files of SAP Customer Activity Repository (RTLCAR) Component

/POSDW/PIPE OSADISPATCHER Status of the execution of the On-Shelf
Availability Parallel Processing of Alerts
report.

For more information, see the SAP Help Portal for SAP NetWeaver at help.sap.com/nw. Choose a release. Under
Application Help, choose |» Function-Oriented View » SAP NetWeaver Library: Function-Oriented View »
Application Server ABAP » Other Services » Services for Business Users » Application Log — User Guidelines (BC-
SRV-BAL) 1.

Archiving
Archiving of Data Used by SAP Customer Activity Repository

If you replicate data from other source systems to SAP Customer Activity Repository using SLT replication, the
replicated data follows the data lifecycle of the source system. As such, when data is archived on the source
system, it is deleted from the repository. Similarly, if you access data of other source systems directly from the
repository (possible when the repository is co-deployed with the source system on the same SAP HANA
database), you do not have access to archived data.

For example, if you archive sales documents in SAP ERP (for example, for performance reasons), these sales
documents will no longer be available in SAP Customer Activity Repository. This could affect your reports if you
choose to have a short lifecycle of sales documents in SAP ERP. For example, if you archive sales documents after
nine months, a year-to-date multichannel sales analysis report in December would miss the sales documents data
for most of the first quarter.

For more information on deployment options for SAP Customer Activity Repository, see [ help.sap.com/car »
Installation and Upgrade Information » Installation Guide 2.

Data Growth and Data Archiving Monitors

The following are the fastest growing tables in SAP Customer Activity Repository:

Table 5
/POSDW/TLOGF Transaction Log Flat table
/POSDW/TLOGF_EXT Transaction Log Extensions table
/POSDW/TLOGF_X Transaction Log Optimized Extensions table
/POSDW/TIBQ Inbound Queue for POS Transactions
/POSDW/TIBQ ADM Management Records of Inbound Queue for POS
Transactions
/POSDW/SOBJL Source Object Link for POS Transactions
/POSDW/PLOG1S Processing Log for Small Logs
/POSDW/TSTAT Areas of Task Status
/POSDW/NAVIX Navigation Index for Store and Day
/POSDW/AGGR POS Aggregate
CUSTOMER
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You can use the SAP HANA Studio to identify which tables use the most disk space. To verify the amount of disk
space used by a table, do the following:

1. Logonto SAP HANA Studio.
Locate the name of your system in the Navigator pane.
Right-click on your system name and select Administration from the context menu.

Select the System Information tab.

ok~ WD

Select the Size of tables on disk entry.
The tables are displayed with their corresponding disk usage values.
SAP Customer Activity Repository uses the standard archiving and monitoring data archiving tools available in

SAP NetWeaver. It does not require any application-specific tools. There are two relevant archiving objects: /
POSDW/AGG and /POSDW/TLF.

The following SAP Notes relate to data growth and archiving in SAP Customer Activity Repository:

e 813537 (General notes about archiving POS data)

e 6525081 (Archiving objects and namespace)

For more information about the standard archiving tools, see the SAP Help Portal for SAP NetWeaver at
help.sap.com/. Choose a release. Under Application Help, choose |» Function-Oriented View » SAP NetWeaver

Library: Function-Oriented View » Solution Lifecycle Management » Data Archiving » Data Archiving in the ABAP
Application System » Data Archiving with Archive Development Kit (ADK) » Archive Administration 3.

Data Load After a Reboot

When you reboot an SAP NetWeaver powered by SAP HANA system, all data that was stored in-memory is lost,
and must be reloaded from the permanent persistency layer of the SAP HANA database. After the reboot, the first
time you run the SAP Customer Activity Repository application, you may experience significant delays as the
application reloads tables such as /POSDW/TLOGF or /POSDW/NAVIX for the first time.

To avoid these delays, it is recommended that you reload all POS Data Management tables with high disk space
usage in the following instances:

® |mmediately following the reboot of your SAP NetWeaver powered by SAP HANA system
®  Prior to launching the SAP Customer Activity Repository application.

First, you must identify which tables use the most memory. See the Data Growth and Data Archiving Monitors
section above.

Then, for each table, run the following SQL command to load the table from the permanent persistency layer into
main memory:

Syntax
load <SAP_ SCHEMA>.”<TABLE NAME>” all

where <SAP_SCHEMA> is the name of your SAP HANA database schema and <TABLE_NAME> is the name of the
table to load. You can verify the database schema of a particular table in SAP HANA Studio using the same
process you use to verify table disk space usage.

You can also create an SQL script that will be automatically executed following an SAP NetWeaver powered by
SAP HANA system reboot. You can use the SAP HANA Studio SQL Editor to create this script, or, you can create
an ABAP report which will include the following commands:

Syntax
EXEC SQL.
load <SAP_SCHEMA>."<TABLE_NAME1>” all.
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load <SAP SCHEMA>.”<TABLE NAME2>" all.
load <SAP SCHEMA>.”<TABLE NAME3>" all.

ENDEXEC.

More Information

For detailed monitoring information about the underlying components of SAP Customer Activity Repository, see
the following:

Table 6
Reference Important Sections or Topics (If
Applicable)
Technical Operations for SAP See SAP Help Portal for SAP NetWeaver | ®  Statistics, Displaying and
NetWeaver at help.sap.com/nw. Choose a release. Controlling Work Processes
Under Application Help, choose [ SAP (SM50)
Library ¥ Administration Information ¥ e System Log (SM21)
Technical Operations for SAP _
o ) e  ABAP Dump Analysis
NetWeaver » Administration of
Application Server ABAP » Monitoring
and Administration Tools for Application
Server ABAP 1.
SLT Application Operation Guide See SAP Help Portal for SAP HANA Changing Load and Replication
Appliance Software at help.sap.com/ Procedures
hana_appliance [p System
Administration and Maintenance
Information » SAP LT for SAP HANA
Technical Operations Manual 1.
SAP HANA Administration Guide See SAP Help Portal for SAP HANA Monitoring SAP HANA Systems
Appliance Software at help.sap.com/
hana_appliance [F System
Administration and Maintenance
Information » SAP HANA Administration
Guides » SAP HANA Administration
Guide 1.

3.3 Detailed Monitoring and Analysis Tools Specific to On-
Shelf Availability

The following function is available to monitor the OSA-specific data flow within the application:

® /POSDW/LOGS: SAP POS DM Application Log
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The SAP POS DM Application Log collects messages, exceptions and errors, and displays them in a log. This
log provides you with basic header information, a message long text, detailed information, and technical
information.

For more information, see the SAP Library Help at |p help.sap.com/nw74/ » Application Help » Function-

Oriented View » SAP NetWeaver Library: Function-Oriented View » Application Server ABAP » Other
Services » Services for Business Users » Application Log - User Guidelines (BC-SRV-BAL) 1.

Trace and Log Files

Trace files and log files are essential for analyzing problems. The SLG1 transaction is used to log and trace ABAP
components. An application log consists of a log header and a set of messages. The log header contains general
data, such as type or created by/on data. Each log in the database also includes the attributes Object and Sub-
Object. These attributes are used to describe and classify the application that wrote the log.

Table 7
/POSDW/PIPE OSADISPATCHER Status of the execution of the On-Shelf

Availability Parallel Processing of Alerts
report.

For more information, see the SAP Library Help at |p help.sap.com/nw74/ » Application Help » Function-Oriented
View » SAP NetWeaver Library: Function-Oriented View » Application Server ABAP » Other Services » Services for
Business Users » Application Log - User Guidelines (BC-SRV-BAL) 1.

Cleanup of growing data

OSA computation data is historized, that is stored with the execution date and time and used in the analysis step
of On-Shelf Availability processing. Because of growing data amounts, SAP recommends to perform a clean-up in
regular intervals. The transaction /0saA/CLEANUP deletes OSA computation data from the SAP HANA Database.

Inthe /0SA/CLEANUP transaction, you can specify the following parameters:

® Therange of stores for which you want to perform the cleanup

® The date range for which you want to perform the cleanup

® Testmode:
o Iftest mode is activated, selected data will be only listed but not deleted
o Iftest mode is deactivated, selected data will be deleted

® Detail level of the messages that will be logged during the cleanup

/0SA/CLEANUP deletes OSA computation data together with run information from the following OSA tables:

® /osa/mon_ana

® /osa/mon_ana_sum

® /osa/ana conf

® /osa/estimat

® /osa/est conf

® /osa/iw pattern

® /osa/iwp_conf

® /osa/monitoring

® /osa/mon_sum

® /osa/mon conf
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The user who executes cleanup needs read and write privileges for the tables that are deleted during cleanup.

Data Growth and Archiving the Monitor Results

The /0SA/STATUSLOG table is the fastest growing OSA table.
Use the saRa transaction to archive the /0SA/STATUSLOG table in regular intervals.

The On-Shelf Availability functionality uses the standard archiving and monitoring data archiving tools available in
SAP NetWeaver. It does not require any application-specific tools. The relevant archiving object is /0SA/STATU.
For more information regarding the standard archiving tools, see the SAP Library Help at |k http://help.sap.com/
nw74/ » Application Help » Function-Oriented View » SAP NetWeaver Library: Function-Oriented View » Solution
Lifecycle Management » Data Archiving » Data Archiving in the ABAP Application System » Data Archiving with
Archive Development Kit (ADK) » Archive Administration 3.

3.4 Data Consistency

SLT Replication

Data can be optionally replicated from SAP ERP and from SAP CRM to SAP Customer Activity Repository. If you
replicate data, the information in the replicated tables must be consistent between the source and the target
systems.

Caution

You can monitor the processes of the SAP Landscape Transformation (SLT) Replication server using the
Configuration and Monitoring Dashboard, as specified in the Alert Monitoring [page 8] section. However, the
dashboard does not currently provide an automated way to monitor the consistency of replicated tables. When
performing SLT replication, you must verify that all the tables required for your SAP Customer Activity
Repository implementation, as well as their contents, are being replicated.

More general information about deployment options and data replication into SAP Customer Activity Repository
is described under [F help.sap.com/car » Installation and Upgrade Information » Installation Guide 1.

Master Data Checking
The system automatically executes the master data checks that you created in the Customizing for POS Inbound
Processing.
The master data checks are processed in the following situations:
® During the inbound processing of POS transactions
e \When the editor is started for a particular POS transaction within the POS Workbench
® \When tasks are processed

The system checks for POS transaction data and automatically enhances it with further data. If there is no valid
master data in the system, the master data check fails and a corresponding error message is displayed. There is
no further processing of the affected POS transaction within the task processing.

If all checks and data enhancements are successful, the system continues executing the functions, without
interruption, according to the guidelines prescribed by which checks were already performed.

You can also check transaction data when executing processing tasks using rules that you have created in
Customizing under | POS Inbound Processing # Tasks » Define Rules 1. Once you have created a rule, you can
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execute a specific activity depending on the result you receive. You create rules when you want to process tasks
only if certain conditions are met.

ABAP Shared Memory Objects

The POS Data Management component of SAP Customer Activity Repository includes functionality to verify
master data in the transactions received from the point-of-sale.

Retrieving master data from database tables through SAP HANA views to perform master data checks for
Material, Unit of Measure, and International Article Number (EAN) can result in slower system performance,
especially in situations when the number of master data records is high. To improve system performance, the
implementation of the master data retrieval uses ABAP shared memory objects to buffer the contents of the
master data tables in a shared memory area of the SAP NetWeaver application server. After the initial load of the
shared memory objects, instead of going to the database to retrieve the required data, the data is retrieved from
the shared memory objects, thereby providing faster data retrieval.

Each version of a shared memory object becomes obsolete 60 minutes after a change lock is released, and the
application server performs an automatic refresh from the database.

Shared Objects Area Management (transaction SHMA) is used to display areas for shared objects and their
properties.

Shared Objects Monitor (transaction sEMM) provides an overview of the area instances in the shared objects
memory of the current application server, and offers selected functions for it.

The following area instances in the shared object memory are relevant for SAP Customer Activity Repository:

Table 8
® /POSDW/CL_MATERIAL BUFFER_AREA The POS Data Management component of SAP Customer

e /POSDW/CL_MARM BUFFER_AREA Activity Repository includes functionality to verify master

datain the transactions received from the point-of-sale.
* /POSDW/CL MEAN BUFFER AREA Master data checks for Material, Unit of Measure, and
International Article Number (EAN) retrieve master data
from database tables through SAP HANA views. The listed

shared memory object allow faster access to this data.

e /POSDW/CL_POSCTRL BUFFER AREA Implementation /POSDW/ANALYTIC DIST ENH IMP of
BAdI: POS Transaction Data Distribution to Item Level
distributes discount amounts from the transaction header to
the transaction line items. This BAdl implementation uses the
listed shared memory object to speed up access to SAP
HANA view sap.is.retail.ecc.ARTICLEPOSCTRL,
which contains information on whether an article is
discountable or not.

Additional general information about ABAP shared memory objects can be found in the SAP NetWeaver
application help at http://help.sap.com/saphelp_nw70/helpdata/en/df/109b8b4b073b4c82da0f2296¢3a974/
frameset.htm

Shared Memory Object Size

Every retail business is different, and as such, the amount of master data, such as the number of articles, or unit
of measure definitions, is also different. The amount of memory required to buffer this master data at the
application server level varies from business to business.
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To set the size of shared memory, do the following:

1.

2.
3.

Execute transaction Rz11 in your SAP Customer Activity Repository system.
Enter abap/shared_objects_size MB as the parameter name and choose Display.

In the Maintain Profile Parameters screen, choose Change Value or |¢ Edit » Change Value 3 (depending on
your SAP NetWeaver version).

Enter the appropriate shared memory size, in MB, in the Current Value field.

We recommend setting the shared memory size to at least 300 MB. Out of this 300 MB, 10-20% is reserved
for the internal administration of shared memory.

For more information on troubleshooting shared memory sizing issues, see the following subsection as well
as SAP Note 1322182.

Restart the application server.

Changes to shared memory size only take affect once the application server is restarted.

Troubleshooting Shared Memory Object Issues

Runtime errors that are related to the use of shared memory objects that can occur are as follows:

Shared Memory Object Sizing Issues

Typically, a runtime error caused by a Cx SHM OUT OF MEMORY exception, indicates that an insufficient
amount of memory is allocated to shared memory.

If your SAP Customer Activity Repository application is terminated as a result of a cCx_SHM OUT OF MEMORY
exception, verify the Runtime Error Long Text provided with the runtime error (this can also be accessed
using transaction sT22). The long text provides the size of the objects that the application was attempting to
load into one of the /POSDW/CL_* BUFFER AREA shared memory objects. You should increase the size of
shared memory, as described in the previous subsection, by at least this amount, plus an additional 10-20%
buffer required for administrative activities.

For example, abap/shared objects size MBis currently setto 300 MB. Your SAP Customer Activity
Repository application produces a runtime error, indicating that 500 MB of fails to load into the /posDuw/

CL MATERIAL BUFFER AREA. You should increase the size of abap/shared objects size MBfrom 300
MB to 850-900 MB and restart the system.

Shared Memory Area Initialization Delays

When SAP Customer Activity Repository performs master data checks to verify material, unit of measure,
and International Article Number (EAN) data, the system verifies the data included in the received POS
transactions against the data buffered in the shared memory objects (/POSDW/

CL MATERIAL BUFFER AREA, /POSDW/CL MARM BUFFER AREA, /POSDW/CL MEAN BUFFER ARER).Ifthe
master data check occurs prior to the initialization of the shared memory area, this can result in a runtime
error caused by a Cx_SHM NO ACTIVE VERSION exception.

The time required to initialize the shared memory area (that is, the time required to load master data from
the database tables into the dedicated shared memory objects) is controlled by the

SHM MAXIMUM PRELOAD WAIT TIME componentofthe SETTINGS parameter used by the CALL method of
BAdI /POSDW/SETTINGS. By default, SHM MAXIMUM PRELOAD WAIT TIME is setto 10 seconds. If you are
experiencing runtime errors caused by aCx SHM NO ACTIVE VERSION exception, you may need to
increase the value of SHM MAXIMUM PRELOAD WAIT TIME to allow for alonger period to initialize the shared
memory area.

For more information, see SAP Note 1965920.
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4 Management of SAP Customer Activity
Repository

SAP provides you with an infrastructure to help your technical support consultants and system administrators
effectively manage all SAP components and complete all tasks related to technical administration and operation.

You can find more information about the underlying technology in the Technical Operations Manual in the SAP
Library under SAP NetWeaver.

4.1 Starting and Stopping

Start and Stop Sequences and Tools

Table 9

SAP HANA Database 1 sapstartsrv See the information about
starting and stopping SAP
HANA systems in the SAP
HANA Administration Guide.

RTLCAR 2 STARTSAP Log on to the host of your
central system as the SAP
Administrator.

Enter startsap ALLto
start the SAP NetWeaver

database, ABAP instances,
and all other processes.

SAP LT Replication Server 3 SAP HANA Studio Use SAP HANA Studio to
(Optional) start replication of tables
required by SAP Customer
Activity Repository.

See | help.sap.com/car »
Installation and Upgrade
Information » Installation
Guide I for information on
deployment options, which
determine whether
replication is necessary. If
replication is required, this
guide also provides
information on how to set up
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table replication and which
tables need to be replicated.

For more information, see the
SAP LT Replication Server
Operations Guide.

SAP LT Replication Service 4 SAP HANA Studio Use SAP HANA Studio to

(Optional) stop replication of tables
required by SAP Customer
Activity Repository.

For more information, see the
SAP LT Replication Server
Operations Guide.

RTLCAR 5 STOPSAP Log onto the host of your
central system as the SAP
Administrator. Enter
stopsap R3.

Note that the R3 switch does
not stop the database
simultaneously. To do so, use
the command stopsap or
stopsap ALL.

SAP HANA Database 6 sapstartsrv See the information about
starting and stopping SAP
HANA systems in the SAP
HANA Administration Guide.

4.2 Software Configuration

This chapter explains which components or scenarios used by this application are configurable and which tools
are available for adjusting.

Table 10
Software Component Configuration Tool(s) Detailed Description
RTLCAR SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository.
RTLPOSDM SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository
under POS Data Management.
RTLMCFND SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository
under Retail Multichannel Foundation.
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Software Component Configuration Tool(s) Detailed Description

RTLDDF SAP Customizing See the documentation in Customizing
for SAP Customer Activity Repository
under Demand Data Foundation.

4.3 Administration Tools

SAP Customer Activity Repository uses the standard SAP NetWeaver administration tools. For more information,
see SAP Help Portal for SAP NetWeaver at help.sap.com/nw. Choose a release. Choose [F System

Administration » Technical Operations Manual » Technical Operations for SAP NetWeaver » Administration of SAP
NetWeaver Systems 1.

SAP Customer Activity Repository also uses the administration tools available with SAP HANA. For more
information, see SAP Help Portal for SAP HANA Appliance software at help.sap.com/hana_appliance. Choose a
release. Choose [F System Administration and Maintenance Information » SAP HANA Technical Operations
Manual 3

4.4 Backup and Restore

You need to back up your system landscape regularly to ensure that you can restore and recover it in case of
failure. The backup and restore strategy of your system landscape must not only include your strategy for your
SAP system, but it must also be included in your company'’s overall business requirements and incorporated into
your entire process flow.

In addition, the backup and restore strategy must cover disaster recovery processes, such as how to recover from
the loss of a data center due to a fire. It is important that your strategy specify that normal data and backup data
are stored in separate physical locations, so that both types of data are not lost in case of a disaster.

SAP Customer Activity Repository is based on SAP NetWeaver technology; therefore, the SAP NetWeaver backup
procedures can also be used for SAP Customer Activity Repository.

More Information

Table 11
Backup and recovery processes for ABAP, JAVA, Business See the Technical Operations Manual for SAP NetWeaver at
Intelligence, or Process Integration help.sap.com/nw. Choose a release. Choose [F System
Administration and Maintenance Information » Technical
Operations Guide » Technical Operations Manual for SAP
NetWeaver 1.
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Backup and restore for SAP systems

See SAP Service Marketplace at service.sap.com/alm-
methodologies | Best Practice Documents # Backup and
Restore for SAP Systems Landscapes 3.

Backing up and recovering the SAP HANA Database

See SAP Help Portal for SAP HANA Appliance Software at
help.sap.com/hana_appliance. Choose a release. Choose
|p System Administration and Maintenance Information »
SAP HANA Administration Guides » SAP HANA
Administration Guide 2.

Backup and restore for Demand Data Foundation

See Administrator's Guide, Demand Data Foundation (DDF)
2.0 with Unified Demand Forecast (UDF) on SAP HANA at
|» service.sap.com/instguides ¥ Industry Solutions ¥
Industry Solution Guides ¥ SAP for Retail » SAP Customer
Activity Repository » SAP Customer Activity Repository
2.0 1

4.5 Load Balancing

For information about load balancing, see the following references:

Table 12

N

Standard functionality of SAP NetWeaver for logon and load
balancing

See SAP Help Portal for SAP NetWeaver at help.sap.com/nw.
Choose arelease. Under System Administration and
Maintenance Information, choose | Technical Operations
Manual for SAP NetWeaver » Solution Lifecycle

Management » High Availability » SAP NetWeaver AS ABAP:
High Availability » Unplanned Downtime for SAP NetWeaver
AS ABAP » Service Configuration for Failure Resilience »
Message Server-Based Logon and Load Balancing
(Redirection) 1.

Partitioning and scale-out for SAP HANA

See SAP Help Portal for SAP HANA Appliance software at
help.sap.com/hana_appliance. Choose a release. Under
System Administration and Maintenance Information, choose
b SAP HANA Administration Guides » SAP HANA
Administration Guide » Scaling for SAP HANA 1.

Partitioning of the /POSDW/TLOGF table

SAP Note 1719282.

Classify TLOG Tables for SAP Customer Activity Repository
Report

See the report documentation (transaction /POSDW/
CLASSIFY TLOG inyour SAP Customer Activity Repository
System) and SAP Note 1980718.

SAP Customer Activity Repository 2.0 SPO1
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e e

Optionally, backup and restore for the SAP Landscape
Transformation (LT) Replication Server (if you wish to start
additional processes in SLT)

1 Note

See |k help.sap.com/car » Installation and Upgrade
Information ¥ Installation Guide 3 for information on
deployment options, which determine whether replication
is necessary.

See SAP Help Portal for SAP HANA Appliance software at
help.sap.com/hana_appliance. Choose a release. Under
System Administration and Maintenance Information, choose
I SAP HANA Technical Operations Manual » Administering
and Operating SAP HANA Replication Technologies # Backup
and Recovery of SAP HANA Replication Technologies 1.
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5 High Availability

SAP Customer Activity Repository is based on SAP HANA and SAP NetWeaver technology; all high availability
considerations that apply to SAP HANA and SAP NetWeaver, such as increasing system availability, improving
performance, and eliminating unplanned downtime, also apply to SAP Customer Activity Repository.

More Information

Table 13

N

General information on high-availability strategies for SAP
NetWeaver-based systems

See SAP Help Portal for SAP NetWeaver at help.sap.com/nw.
Choose arelease. Under Application Help , choose

|# Function-Oriented View ¥ Solution Life Cycle

Management » SAP High Availability 2.

General information on high availability strategies for SAP
HANA based systems

See SAP Help Portal for SAP HANA Appliance software at
help.sap.com/hana_appliance. Choose a release. Under
System Administration and Maintenance Information, choose
| SAP HANA Technical Operations Manual » Administering
and Operating SAP HANA » High Availability 3.

SAP Customer Activity Repository 2.0 SPO1
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6 Software Change Management

Software Change Management standardizes and automates software distribution, maintenance, and testing
procedures for complex software landscapes and multiple software development platforms. These functions
support your project teams, development teams, and application support teams.

The goal of Software Change Management is to establish consistent, solution-wide change management that
allows for specific maintenance procedures, global rollouts (including localizations), and open integration with
third-party products.

This section provides additional information about the most important software components.

6.1 Transport and Change Management

Component Change Management Tools

Table 14
Component Solution Manager Maintenance Transport Management Too
Optimizer Integration
RTLCAR Yes SAP NetWeaver Transport Organizer
RTLPOSDM Yes SAP NetWeaver Transport Organizer
RTLMCFND Yes SAP NetWeaver Transport Organizer

6.2 Development Requests and Development Release
Management

You use the standard tools and procedures of SAP NetWeaver to transport SAP Customer Activity Repository
code extensions or Customizing changes. All such changes are captured by the transport system and are
transportable.

More Information

Table 15
N
Change and Transport System See SAP Help Portal for SAP NetWeaver at help.sap.com/nw.

Choose arelease. Under System Administration and
Maintenance Information, choose | Technical Operations for
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SAP NetWeaver » Administration of Application Server
ABAP » Change and Transport System 1.

Change Management for SAP HANA-based systems See SAP Help Portal for SAP HANA Appliance software at
help.sap.com/hana_appliance. Choose a release. Under
System Administration and Maintenance Information , choose
| SAP HANA Technical Operations Manual ¥ Administering
and Operating SAP HANA » Change Management 1.

Manual ABAP on SAP HANA correction process See SAP Note 1798895.

6.3 Support Packages and Patch Implementation

We recommend that you implement SAP NetWeaver, SAP HANA and SAP Customer Activity Repository support
package stacks, which are sets of support packages and patches for the respective product version that must be
used in the given combination. The technology for applying support packages and patches will not change

You can find detailed information about the availability of SP stacks for SAP Customer Activity Repository on SAP
Service Marketplace at service.sap.com/sp-stacks. See the corresponding Release Information Notes (RIN)
before you apply any support packages or patches of the selected SP Stack.

Use the Maintenance Optimizer (transaction Dswp) in SAP Solution Manager to select, download, and install the
needed usages, or software components and required support packages.

More Information

Table 16
e e
SAP Solution Manager See SAP Help Portal for SAP Solution Manager at
help.sap.com/solutionmanager.
SAP Solution Manager Change Management Maintenance See SAP Service Marketplace at service.sap.com/solman-
Optimizer mopz.
SAP Add-on Installation Tool See the documentation for transaction SAINT in your SAP
system.
Implementation of support packages and possible side See service.sap.com/patches|F SAP Support Packages in
effects detail 3.
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7 Troubleshooting

7.1 Troubleshooting Information Specific to On-Shelf
Availability

Viewing Back-End Error Messages

Back end error messages are saved in the Gateway system. To access these error messages, perform the
following steps:

1. Starttransaction /IWFND/ERROR_LOG.

2. Select the log entry, and choose Error Context.

3. Choose Application Log.
4

Note down the error number of each message with the following message text: This is an external
message. Access message text via details

5. Choose Detail exists to view the text of each external error message.

Cleaning Up Gateway Cache

You can clean up the cache on the Gateway server by running transaction /IWEND/cache cleanup. Cleaning up
cache on the back end using transaction /IWBEP/cache cleanup is also recommended.

Verifying BAdl Implementations

The On-Shelf Availability functionality requires that the BAdIs found in Customizing under [ SAP Customizing
Implementation Guide » SAP Customer Activity Repository » On-Shelf Availability » Enhancements Using Business
Add-Ins 3 have an implementation.

In the case that a BAdI does not have an implementation specific to your business scenario, you can expect the
following behavior from the On-Shelf Availability functionality.

Table 17
Process Shelf Status Change Notifications No error occurs, no on-shelf availability alerts will be
reported.
Retrieve Algorithm Detection Time Runtime error in On-Shelf Availability when executing the
OSA algorithm.
Retrieve Department Data Runtime error in OData Service.
Retrieve Sub-Department Data Runtime error in On-Shelf Availability when executing the
OSA algorithm.
Retrieve Product Data Runtime error in OData Service.
Retrieve Additional Product Information Data No error occurs, no additional product information (such as
promotion and layout) will be available.
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Retrieve Listed Product Data Runtime error in On-Shelf Availability when executing the
OSA algorithm.

Retrieve Product Inventory Data No error occurs, product inventory information will not be
available.

Retrieve Image URL Data No error occurs, product images will not be available.

Retrieve Store and Factory Calendar Data Runtime error in OData Service.

Troubleshooting On-Shelf Availability Algorithm Results

The following Customizing settings under |» SAP Customizing Implementation Guide » SAP Customer Activity
Repository » On-Shelf Availability ¥ Initialize On-Shelf Availability Algorithm 3 can have the most impact on the
results of the OSA algorithm:

Level Of Granularity

This setting impacts on which level the intra-week pattern analyzer step of the OSA algorithm will be
executed: on product, sub-department or store level. For example, when the Level of Granularity is set to
2000, you need transactional information containing 2000 x 2.5 times the number of instances at which the
product was sold during the period specified in the Number of Weeks setting. To run the intra-week pattern
analyzer step at the product level, the product must have been sold 5000 times at the store considered by
the algorithm. To run the intra-week pattern analyzer step at the sub-department level, products of that sub-
department must have been sold 5000 times at the store considered by the algorithm. To run the intra-week
pattern analyzer step at the store level, 5000 products must have been sold by the store in the specified
Number of Weeks setting.

Minimum Transaction Threshold

This setting determines which products will be considered when the estimation model step of the OSA
algorithm is executed: products included in fewer transactions than specified in the Minimum Transaction
Threshold setting during the period specified in the Number of Weeks setting will be excluded. For example, if
the Minimum Transaction Threshold setting is 50 and the Number of Weeks is set to 13, then a product will be
excluded by the estimation model if it is sold in fewer than 50 transactions during a 13 week period.
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8 Support Desk Management

Support Desk Management enables you to set up an efficient internal support desk for your support organization
that seamlessly integrates your end users, internal support employees, partners, and SAP Active Global Support
specialists with an efficient problem resolution procedure.

For support desk management, you need the methodology, management procedures, and tools infrastructure to
run your internal support organization efficiently.

Remote Support Setup

If you want to use SAP remote services (for example, SAP EarlyWatch or Remote Consulting), or if you would like
to permit an SAP support consultant to work directly in your system to make a more precise problem diagnosis,
then you need to set up a remote service connection.

Additionally, there exists an ABAP role for read-only access for remote support that is also relevant. This role
(sap_RcA_SAT DIsPfor ABAP)is available inthe STPI plug-in and is generated when a managed systemis
connected to SAP Solution Manager.

Should any additional application-specific functionality be necessary for use by an SAP support consultant, then
an applicable role should be defined providing the appropriate authorization(s) and assigned to the SAP support
consultant’s user login.

Problem Message Handover

To create SAP support messages for your installation, you must specify an application component. For SAP
Customer Activity Repository, you can specify one of the following application components:
® CA-RT-CAR-PIP — toenter support messages for the POS Data Management component (POS data
transfer and audit).

® CA-RT-CAR-ANA — to enter support messages for SAP HANA Content delivered with SAP Customer Activity
Repository.

® CA-RT-CAR-INT — to enter support messages for integration with the DDF/UDF component and the
integration between the repository and consuming applications.

® CA-RT-CAR — to enter support messages for general issues with SAP Customer Activity Repository that
cannot be easily classified into one of the categories above.
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9 Appendix

9.1 Transaction Log (TLOG) Data Model and Storage

POS data is captured in a format called a Transaction Log (TLOG). TLOGs capture all the attributes of a store’s
sales transaction. This information is used to log many attributes about the sale, such as customer information,
sales price, discount price, quantities, item descriptions, and much more. Such information is used in backend
store systems for sales auditing, reporting, and input in to additional Retail planning applications.

SAP Customer Activity Repository is an application that serves as a central repository for storing TLOG data. In
addition to storing and providing many business functions that operate directly on the TLOG data (for example,
Sales Audit), SAP Customer Activity Repository also captures and exposes the data in a standard way so that it
can be easily consumed by analytical, planning, and other follow-on applications.

Business Transactions

The POS transaction data model is the most important business object in the POS Inbound Processing Engine
(PIPE). At the POS, different kinds of business transactions can be recorded by a cash register, for example:

® POSsales

® (Cash pay-in/pay-out

® |nventory Adjustments (for example, spoilage or unexpected goods receipt)

® Register closing (for example, count cash amount in the till)

e  Statistical events (for example, cash drawer opened, store opening, and cashier log on)

In order to simplify the programming interfaces, the SAP Customer Activity Repository POS transaction data
model is based on a generic approach that allows different kinds of POS transactions to be stored in the same
database tables. A qualifier, called a transaction type code, is used to distinguish which kind of business
transaction the POS transaction reflects. For one business transaction, there can be more than one transaction
type. For example, a retail transaction can be either a sale or an employee sale, but both are sales transactions.

The figure Business Transaction Types for POS Transactions shows the business transactions that can be used to
classify generic POS transactions. Technically, this classification is used to define a subset of segments that can
be used by a specific business transaction. For example, a financial transaction may not include any goods
movement items because this sub-structure belongs to goods movement transactions only.

Located at the header level of a POS transaction, the business transaction field uses fixed values to indicate the
transaction type, as shown in this figure.

POS-
Transaction

R
[ [ [ ] 1 1

. - - Goods
Retail Financial e et Totals Control Reversal
Transaction Transaction ST ey Transaction Transaction Transaction

Figure 2: Business Transaction Types for POS Transactions

The following sections describe the relationship of the POS transactions on the segment level. Segments are
stored in internal tables. They can contain more than one line. Although it is technically possible to store multiple
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lines in all segments, some segments may contain only a single record. In the following sections, the hierarchy of
the segments and the cardinality is explained in detail.

Common Segments
Transaction Header

All POS transactions share the same header segment. Some header fields are mandatory and must be filled out in
order for SAP Customer Activity Repository to process the data. Some header fields are optional in SAP
Customer Activity Repository but are required from a business point of view.

The transaction header contains the following information:

Table 18: Transaction Header Fields

Field Name Description Role in SAP Customer | Role at POS Data Type/Length

Activity Repository

Retail Store ID A unique identifier of Key Key Char/10
the store where the
POS transaction was
entered. This field
usually contains the
customer number of
the plantin ERP to
which the store is
assigned.

Business Day The date to whichthe | Key Key Date
POS transaction is
assigned. In Retall, itis
referred to as the
business day or
posting date. In some
cases, the business
day is not the actual
date on which the
transaction transpired
but to whichiitis
assigned. For example,
ina24/7 business, a
cashier’'s work shift can
be from 23:00 until
03:00 and sales
transactions that
transpire after 00:00
are assigned to the
previous day.

Transaction Index A counter that uniquely | Key - Integer/4
identifies POS
transactions for the
same store and same
business day. This field
is available only in SAP
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Field Name

Description

Customer Activity
Repository and has no
representation in the
external interfaces or
at the POS.

Role in SAP Customer

Activity Repository

Role at POS

Data Type/Length

Transaction Type Code

A four-digit code used
to indicate the type of
POS transaction.

Mandatory Attribute

Mandatory Attribute

Char/4

Workstation ID

A number that
identifies the cash
register or machine
where the POS
transaction was
entered.

Optional Attribute

Key

Char/10

Transaction Number

A number used to
identify a POS
transaction. In SAP
Customer Activity
Repository, the key
fields (store, business
day, workstation ID,
transaction type code,
and transaction
number) do not need
to be unique because
SAP Customer Activity
Repository uses a
counter at the
database level.
However, the key field
combination must be
unique at the POS.

Optional Attribute

Key

Char/20

Begin Time Stamp

The date and time the
POS transaction was
started. When the
cashier enters a new
POS transaction, the
time is stored in the
transaction header.
This information is
required to put the
transactions in
sequential order, and is
also used to assign

SAP Customer Activity Repository 2.0 SPO1
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Char/14
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Field Name

Description

retail transactions to
totals transactions
(see Totals
Transactions) for the
balancing or short/
over calculation.

Role in SAP Customer

Activity Repository

Role at POS

Data Type/Length

End Time Stamp

The date and time the
POS transaction was
completed. This field is
mandatory in SAP
Customer Activity
Repository. It may be
filled with the begin
time stamp, unless a
second time stamp is
available. By
completing a POS sale,
the time stamp is also
entered in the
transaction header.

Mandatory Attribute

Optional Attribute

Char/14

Department

A number that
identifies the
department of the
store.

Optional Attribute

Optional Attribute

Char/10

Operator ID Qualifier

Itis used to identify the
cashier who entered
the POS transaction or
the user who entered
the business
transaction.

Optional Attribute

Optional Attribute

Char/30

Operator ID

Itis used to identify the
cashier who entered
the POS transaction or
the user who entered
the business
transaction.

Optional Attribute

Optional Attribute

Char/30

Transaction Currency

CUSTOMER

The transaction
currency to which all
retail line items are
assigned. For retail
transactions, this field
is optional because all
retail transactions in
the same store are
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Field Name

Description

usually assigned to the
same currency, even if
the payment can be
done in different
currencies. The
transaction currency
can differ from the
tender currency. If the
transaction currency is
not provided, a default
currency must be
defined in the SAP
Customer Activity
Repository
Customizing. However,
for tender totals, the
field is mandatory as
there can be totals for
different currencies.

Role in SAP Customer

Activity Repository

Role at POS

Data Type/Length

Partner ID Qualifier

This field indicates if
the transaction is from
a customer or business
partner.

Optional Attribute

Optional Attribute

Char/1

Partner ID

Itis used to store the
SAP customer number,
SAP personnel
number, or a free text
value.

Optional Attribute

Optional Attribute

Char/13

Receipt Handling Time

Specifies the time, to
the millisecond,
required to complete
the handling of the
receipt.

Optional Attribute

Optional Attribute

Dec/13,3

Register Time

Specifies the time, to
the millisecond,
required for the
registering of the
transaction line items.

Optional Attribute

Optional Attribute

Dec/13.3

Tendering Handling
Time

Specifies the time, to
the millisecond,
required to complete
the transaction
payment (tender).

Optional Attribute

Optional Attribute

Dec/13.3
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Field Name Description Role in SAP Customer | Role at POS Data Type/Length
Activity Repository
Pause Time Specifies the time, to Optional Attribute Optional Attribute Dec/13,3
the millisecond, that
the cash register
spends in pause mode
between two
transactions.
Training Time Specifies the time, to Optional Attribute Optional Attribute Dec/13,3
the millisecond, that
the cash register
spends in training
mode.
Drawer Number Used | Specifies the cash Optional Attribute Optional Attribute Char/10
at POS Client drawer identifier used
at a POS client.
Customer ID from POS | Specifies the customer | Optional Attribute Optional Attribute Char/16
identifier.
Customer Age Specifies the age of the | Optional Attribute Optional Attribute Integer/5
customer.
Customer Identifier Specifies the method Optional Attribute Optional Attribute Char/1
Entry Method used to enter the
customer ID.
Reference to Original Specifies the retail Optional Attribute Optional Attribute Char/10
Receipt for Retail Store | store identifier of the
ID referenced transaction.
Referenced to Original | Specifies the posting Optional Attribute Optional Attribute Date
Receipt for Posting date of the referenced
Date transaction.
Reference to Original Specifies the POS Optional Attribute Optional Attribute Char/10
Receipt for number (cash register
Workstation ID number) of the
referenced transaction.
Reference to Original Specifies the Optional Attribute Optional Attribute Char/20
Receipt for Transaction | transaction identifier
Number (receipt number) of the
referenced transaction.
Reference to Original Specifies the start Optional Attribute Optional Attribute Char/14

Receipt for Start timestamp, as appears
Timestamp on the referenced
transaction
CUSTOMER
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Field Name Description Role in SAP Customer | Role at POS Data Type/Length
Activity Repository

Reference to Original Specifies the original Optional Attribute Optional Attribute Char/10
Receipt for Line Iltem line item number of the

Number referenced transaction.

Reason Specifies the reason Optional Attribute Optional Attribute Char/4

code for referencing
data from the original
receipt.

Post Void Details

Post void details are included in the header information. Post void details provide two types of information:
e Aflagto mark atransaction to be voided

e Areference to another transaction that was voided. Note that this information can only be part of a post void
transaction. See Post Void Transactions.

Any POS transaction can be flagged to be voided; therefore the structure for post void details can be used in
combination with all business transaction types. However, only post void transactions can contain a reference to a
voided transaction.

SAP Customer Activity Repository tasks can be configured to filter out voided transactions automatically.

For more information on post void details, see Post Void Transactions.

Extensions

The POS transaction data model used by SAP Customer Activity Repository includes predefined locations where
you can insert extension segments to enhance the standard data model with customer-specific fields.

Extensions can exist on different levels in a transaction, therefore extension segments can occur on the
transaction header level, on the item level (for example, retail line item, tender, or goods movement item), or even
lower than the item level.

For more information, see Extensibility and Extensions.

Transactional Additionals

The transaction additionals segment contains information about the entry of the transaction, for example, a
transaction reason code or a training transaction indicator.

Retail Transactions

A retail transaction contains the most relevant information about a POS sale, such as retail line items and tender
information.

A retail line item reflects a quantity of a single article that was scanned or manually entered at the POS. For each
retail line item, there can be discounts, taxes, loyalty information or commission information that applies to it.
Depending on the business case or business use, discounts, taxes, and loyalty information may can also exist at
the transaction level.

Some fields in the retail line item are used very rarely. These are stored in a sub-structure called retail
additionals.

After all items have been entered at the POS, and the customer has paid, the relevant information is stored in the
tender segment, which stores information about the means of payment. For credit card or debit card
payments, there are sub-structures that contain information about the card number, card owner, and the
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authorization code sent by the credit card authorization service. If the credit card information is available only in
an encrypted format, it is stored in the secure bin data segment.

Information about the customer, such as age, phone number and, address, can be added at the POS by use of the
customer details structure which offers the same kind of enhancement concept as the extensions
structures (see Extensibility and Extensions).

Retail 1 0.1 | Transaction
Transaction Additionals

0.1 Post Void
Details.

A — 1 0.1 Line Item
i Retail Line Void

tem

L

- Line Item <

4 Extensions
Discount

= Line Item

*

Commission

Retail
Additionals

0..

1.+

Loyalty Extensions

*

Extensions

* *

Discount Extensions

*| Creditcard
Tender

| Directdebit
& Secure
Bin Data o

e

Fleet
* Customer
Details

* ’ Coupon Ref
ltem

Coupon

*
Extensions

N *
IIII E. |:
X

*

Figure 3: Structure of a Retail Transaction

Totals Transactions

Totals transactions are used to process aggregated information for different kinds of POS transactions such as:
e Retail Totals: Aggregated retail amount and number of items for each retail type code
® Tax Totals: Aggregated tax amount and number of items for each tax type code
® Discount Totals: Aggregated reduction amount and number of items for each discount type code

e Tender Totals: Aggregated tender amount, number of items, actual amount, short amount, over amount,
removed amount, and other details for each type code

e (Cashier Totals: Aggregated statistical information for loss prevention purposes, for example, the number of
retail transactions with a value of zero, the number of cash drawer openings, and other details

At the end of a day or a cashier shift, the cash register can send a summary record that contains these different
kinds of totals.

The summary information has different purposes:

® Technical Balancing: Identifies missing or duplicate detailed information by comparing the summary records
and POS transactions

e Short/Over Processing: Identifies differences between the actual amount and the expected tender amount
(especially cash) at a workstation or cashier level, and sends the differences to financials

® | oss Prevention: Identifies fraudulent activities at the POS by use of statistical patterns, especially the
cashier totals
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Technically, it is possible to include different kinds of totals in the same totals transaction.

As arule, the two time stamps that are part of the transaction header are used to identify the time interval for
which the totals have been calculated. If the attributes at the header level, such as operator ID or workstation ID
(see Transaction Header) are filled, the summary information is associated to a specific cashier or cash register.
Otherwise they are valid for all cashiers or workstations.

Totals 1 0.1 Post Void
Transaction R Details
* 1 *
N Retail Totals Extensions
"1 Tax Totals
\ *| Discount
Totals
L * Tender
Totals
. 1 =*
\ * Cashier .
Totals Extensions
— Extensions

Figure 4: Structure of a Totals Transaction

Goods Movements

Goods movement transactions are used to enter goods movements at the POS. They can be entered for reasons
such as:
®  Spoilage: In this case, the quantity of goods available for sale is decreased and has to be adjusted in inventory
management
® Transfer posting: Goods can be transferred from one store to another without any kind of settlement
® Reserve goods: A customer can call and ask to reserve an article for pickup the next day. If this transaction is
to be reflected in the inventory account, the article can be transferred from the stock at hand to the reserved
stock.
The goods movement transaction consists of a transaction header and a number of goods movement items,
reflecting the inventory-related movement at the article level.
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Figure 5: Structure of a Goods Movement Transaction

Financial Movements

Financial movements represent financial transactions with or without an impact on the cash amount at the POS,
such as:
® (Cashremovals or deposits: Money is removed from the cash register, for example, as a deposit it is brought
to the bank, or new change is paid-in. In these cases, the financial amount is moved within the company.
® Pay-In and Pay-Out Transactions: For example, money is paid-in for services, wages, or a pay-in for a
customer, or paid-out for wages. In these cases, the financial amount is moved out of or into the company.
The financial transaction consists of a transaction header and a financial movement item, which contains an
amount of money to be booked on a certain account.
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Financial 1 0.1 Transaction
Transaction Additionals

L 0..1 Post Void
Details

14 Financial 1 *
—— Movement [&—— Extensions
Item

“—— Extensions

Figure 6: Structure of a Financial Movement Transaction

Control Transactions
Control transactions represent events that are tracked for statistical reasons only or to document certain
processes, such as:

® (Cashier Logon/Logoff or Logon Attempt: For loss prevention purposes, data about the time when a cashier
logged on and off a cash register is collected

® Open Register/Close Register: For loss prevention purposes, data about the time when a cash drawer was
opened without a corresponding sales transaction is collected

® Repeat Printout: Records when a cashier prints out for a second time
e Store Opening: The time the store opens
e Suspend/Retrieve Transaction: For detecting fraud patterns, data about suspended transactions is collected

A control transaction consists of a transaction header. It is classified by a transaction type code and a timestamp.
If more information needs to be transferred, an extension segment can be used.
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Figure 7: Structure of a Control Transaction

Post Void Transactions

A post void transaction represents the reversal of a POS transaction that was previously processed. For several
business reasons and in unusual cases, it can be necessary to cancel an entire POS transaction, for example, if a
POS sale has been completed but the customer is not able to pay, or a goods movement was booked by mistake.

There are two possible post void scenarios:
1. The original POS transaction has already been processed in the back-end system.

In a trickle-feed scenario, POS transactions are sent to SAP Customer Activity Repository many times during
the day. In this case, the original POS transaction has already been processed and can no longer be marked
as a voided transaction at the cash register.

2. The original POS transaction has not yet been transferred to the back-end system.

Because sales transactions are uploaded only once a day, the cash register will automatically flag the original
POS transaction to be voided. In this case, no post void transaction is necessary because the original sale can
be flagged as a voided sales transaction.

In the second case, the post void transactions need to be transferred to SAP Customer Activity Repository
because the cash register has already marked the original transaction to be “invalid”. If this is technically not
possible or if the first case applies, the reversal processing needs to be done in SAP Customer Activity Repository.
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Post Void
Transaction

POS Transaction Tables (/POSDW/TLOGF)

In SAP Customer Activity Repository, POS transactions are stored in one table, the /PoSDW/TLOGF table. This

0..1 Transaction
Additionals
L 0.1 Post Void
Details
\ A Customer
Details
“— Extensions

Figure 8: Post Void Transactions

table has the following characteristics:
® Persisted only in the SAP HANA database

® NoBLOB fields

® Column-based

® (Can store up to two years of non-aggregated POS transaction data. Note that the amount of data stored is

deployment-specific and is determined by the customer.

/POSDW/TLOGF Table

In the SAP Customer Activity Repository application layer, /POSDW/TRANSACTION INT structureis the internal

representation of the pos transaction data.
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Figure 9: POS Transaction Structure

In the database layer, the pPOs transaction data is stored in the /POSDW/TLOGF table.

The /POSDW/TLOGF table is a column-based, flattened version of the /POSDW TRANSACTION INT structure,
where all the fields of the structure are stored in one table.

Flattening the TLOG Data Model into /POSDW/TLOGF

As described in the previous sections, POS transactions are stored as a tree structure in /PoOSDW/
TRANSACTION INT. Theroot node of a POS transaction contains header information such as transaction type
and transaction number. The header fields are common to all POS business transaction types. In addition to the
header fields, there are tables in the data structure that represent information from different business transaction
types.

In order to transform this tree structure into a flat table (that is, a table that contains no additional tables), the
approach is similar to the approach previously used by SAP POS DM 1.0 to supply BW DataSources: a record
qualifier attribute is introduced for each row. This is not the same record qualifier that was used for POS analytics.
Although similar, the /POSDW/RECORDQUALIFIERID data element is specific to the /POSDW/TLOGF table. For
more information, see SAP Note 811393.

For a flattened T1.0G data model (/POSDW/TLOGF), the following record qualifiers are used:

Table 19: Record Qualifiers

1 Transaction Header
2 Post Void Details
3 Additionals
4 Customer Details
5 Retail Line Item
CUSTOMER
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6 Discount

7 Discount Extension

8 Tax

9 Tax Extension

10 Line Item Void

11 Line Item Discount

12 Line Item Discount Extension
13 Line Item Tax

14 Line Item Tax Extension

15 Line Iltem Commission

16 Line Item Extensions

17 Line Item Retail Additionals
18 Line Item Loyalty

19 Line Item Loyalty Extension
20 Line Item Refund Details

21 Tender

22 Financial Movement

23 Goods Movement

24 Goods Movement Extension
25 Extension

26 Loyalty

27 Loyalty Extension

29 Financial Movement Extension
30 Tender Credit Card

31 Tender Direct Debit

32 Tender Fleet

33 Tender Extension

34 Retail Totals

35 Tax Totals

36 Tender Totals

37 Cashier Totals

SAP Customer Activity Repository 2.0 SPO1
Appendix

CUSTOMER
© Copyright 2015 SAP SE or an SAP affiliate company.
All rights reserved. 43



38 Cashier Totals Extension
39 Discount Totals
40 Tender Coupon

Extensibility and Extensions

As comprehensive as the SAP Customer Activity Repository POS transaction data model is, you can enhance it if
you need to store non-standard data directly in each transaction record. For example, you can store comments
that a cashier enters about a particular POS transaction directly in the POS transaction log. There are no standard

fields to store cashier comments in the TLOG data model, therefore you use an extension segment.

Extension segments support customer-specific fields by storing them without having to alter the table definition.
The extension segment concept also provides customers with the flexibility to store and process the extensions
together with the rest of the transaction.
Extensions and the Internal TLOG Structure (/POSDW/TRANSACTION INT)
The SAP Customer Activity Repository POS transaction data model handles customer enhancements and
extensions by including tables of name-value pairs (/POSDW/TT EXTENSIONS with line type /POSDW/
EXTENSIONS) at predefined locations as extension segments.

i E'I' Structure /POSDW/EXTENSIONS

Customer Enhancements

¥ O Include structure /POSDW/EXTENSIONS_FI

Customer Enhancements

~ 00 Include structure /POSDW/EXTENSIONS_FD

Customer Enhancements - Database Fields

+ {& FIELDGROUP
+ & FIELDNAME
+ O FIELDVALUE

/POSDW/FIELDGROUP Field Group CHAR
/POSDW/FIELDNAME  Field Name CHAR
/POSDW/FIELDVALUE Field Value CHAR

5
10
40

User Interface Data: Customer Extension

} OO Include structure / POSD‘A!/EXTENSIONS_FU

Figure 10: /POSDW/EXTENSIONS Structure

These extensions exist on different levels: there are extension segments at the header level, at the item level (such
as retail line items, tender movement items or goods movement items), and at lower levels. The field names can

be grouped in order to reproduce data structures.

44
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Figure 11: Extension Level Details

Extensions and the Physical Data Storage

By default, customer extensions are carried through and stored in the /POSDW/TLOGF table as a name-value pair,
but using dedicated extension record qualifiers.

For example, if a transaction header includes the cashier's comment for the transaction, a record (with a record
qualifier 25) is inserted in the /POSDW/TLOGF table, and this record includes the extensions information as a
name-value pair. FIELDGROUP can be set to COMNT (comments), FIELDNAME to CASHIER (another value could be
MANAGER) and FIELDVALUE can store the comment, for example, “Customer was happy about sale on jeans”.

Inthe /POSDW/TLOGEF table, you would see the following:

Data Browser: Table /POSDW/TLOGF Select Entries 200
G @ M4 r M ETFE RSB checkTable..

Fixed Columns: 5 List Width 0250

MANDT | RETATLSTORETD | BUST ROWKEY | PARENTKEY IFTER | TRANSTYPECODE FIELDGROUR | FIELDNAME | FIELDVALUE

100 [r1i00 01.10.2012 il [} [ 1 1001 COMNT CASHIER | Customer was happy about sale on jeans

Figure 12: Example in /POSDW/TLOGF table

Storing Extension Segments in a Separate Table

If you have a large number of extensions, they can significantly increase the size of the /pPosDW/TLOGF table, and
potentially slow down database operations on the table.

To speed up database operations on the /POSDW/TLOGF table, you can store extension segments in a dedicated
table (/POSDW/TLOGE EXT) by enabling the Store Extensions in Separate Table option in the Define General
Settings Customizing activity.

The setting of the Store Extensions in Separate Table option affects how POS transaction data is stored in the
database. This option should be set after consultation with a SAP Customer Activity Repository administrator,
and you should not change the selected setting of the Store Extensions in Separate Table option needlessly.

Only transactions processed after the Store Extensions in Separate Table option is enabled will have their
extension segments stored in the /POSDW/TLOGF_EXT table. For all the POS transactions already stored in the /
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POSDW/TLOGF table, you must run the Transfer POS Transaction Extension Segments Report (transaction /
POSDW/REFE) to move the extension segments from the /POSDW/TLOGF table to the /POSDW/TLOGFE EXT table.

If you have been storing extension segments in the /POSDW/TLOGF EXT table, you can use the Transfer POS
Transaction Extension Segments Report to move the extension segments back to the /POSDW/TLOGF table.

Note that the actual persistence location of extension segments (/POSDW/TLOGF or /POSDW/TLOGF EXT) has no
impact on the inclusion of these extension segments in their corresponding transaction records during task
processing, display in the POS Workbench or analysis.

Mapping Extension Segments

If you have a large number of extensions, they can significantly increase the size of the /POSDW/TLOGFEF and/or
the/POSDW/TLOGF_EXT tables, and potentially slow down database operations on the tables. Additionally, if you
would like to consume extension data for analytical purposes, the standard storage of extensions may not yield
adequate performance for the retrieval of this type of information.

To optimize the storage of extension segments, you can define how a given name-value pair for a specific store
extension segment should be mapped instead into a new dedicated field within either the /pOsDW/TLOGF or /
POSDW/TLOGFE X tables by providing this criteria in the Maintain TLOGF Customer Enhancement Field Mapping
Customizing activity. The new dedicated fields are defined using an APPEND structure on the relevant targeted
table (/POSDW/TLOGF or /POSDW/TLOGF X).

The definition of extension field mapping criteria in the Maintain TLOGF Customer Enhancement Field Mapping
customizing activity affects how POS transaction data is stored in the database. This option should be set after
consultation with a SAP Customer Activity Repository administrator. You should not change the defined criteria of
the Maintain TLOGF Customer Enhancement Field Mapping Customizing activity without taking proper
precautions, since any changes can have potentially negative impacts.

Only transactions processed after the definition of the field mapping criteria in the Maintain TLOGF Customer
Enhancement Field Mapping Customizing activity will have their extension segments stored in the /POSDW/TLOGF
or /POSDW/TLOGF_X table. For all the POS transactions already stored in the /POSDW/TLOGF & /POSDW/

TLOGF EXT tables, you must run the Transfer POS Transaction Extension Segments report (transaction /posDw/
REFE) to move the extension segments from the /POSDW/TLOGF or /POSDW/TLOGF EXT table to the proper
targeted field of the targeted table (either the /POSDW/TLOGF or /POSDW/TLOGF X table).

If you have been previously mapping extension segments in the /POSDW/TLOGF and/or /POSDW/TLOGF X tables
and you wish to make a change or undo this mapping, you can use the Transfer POS Transaction Extension
Segments report to move the extension segments back to the regular name-value pair storage in the /posbpw/
TLOGF or /POSDW/TLOGF_EXT table.

1 Note

The actual persistence location of extension segments (/POSDW/TLOGF, /POSDW/TLOGF EXT, Of /POSDW/
TLOGF_X) has no impact on the inclusion of these extension segments in their corresponding transaction
records during task processing, display in the POS Workbench or analysis.

9.2 TLOG API

The following function modules are used to perform standard CRUD operations on the /POSDW/TLOGF table:

® /POSDW/READ_TLOG
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® /POSDW/WRITE_TLOG
® /POSDW/SEARCH_TLOG

These function modules are part of the /posDw/TLOG API function groups that reside in[r /POSDW/STRUC » /
POSDW/PIPE » /POSDW/DATABASE 1.

IPOSDWITLOG_AP!

FM (POSDW/

FM /POSDW/READ_TLOG SEARCH_TLOG

FM /POSDW/WRITE_TLOG | |

AUSESH

sabatracts
IPOSDWICL_DATA_SOURCE

Signature Change:

fetch_next_tlog(y -> fatch_next_thog_ds(} m-":‘g-"'; m mmmyﬁmﬂ

write_togs() -> write_tlogs_ds{) wite Ao b check i e asdwaoe

read_tiog(} = read_tiog_ds{) i B a3t L oot e pOBMSH)

search_tlog() -> search_tlog_ds(} :,!-ﬂ.'to lmm;om ot tlog tyo= ty ¥ Hoge)
me_wemwm &l hyne Sposdwiog)

ssach Togleteck ol Seg e ty 1t togs)

T
| |

‘ {POSDWICL_DATA_SOURCE_DB l

POSDW/
CL_DATA_SOURCE_BUFFER

——

1POSDW/ 1POSDW/
CL_DATA_SOURCE_ARCHIVE CL_DATA_SOURCE_AR_HDB_F

/POSDW/
CL_DATA_SOURCE_FLAT_HDB

)

TLOGF

Figure 13: Structure of TLOG_API

The following APIs are used to perform standard CRUD operations on the /POSDW/TLOGF table:

Table 20: APIs used for the /POSDW/TLOGF Table

T S N

/POSDW/READ_TLOG Function Module This function module reads the
POS transactions from the
POS transaction database.

/POSDW/SEARCH_TLOG Function Module This function module searches
the POS transaction database
for records matching the
selection criteria.

/POSDW/WRITE_TLOG Function Module This function module writes
the POS transactions to the
POS transaction database.
Existing records with the same
key are overwritten.

/POSDW/CL_DATA_SOURCE_FLAT_HDB Class Represents the Data Access
Object used to perform basic
table CRUD operations.
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Figure 14: Sequence Diagram for /POSDW/READ_TLOG Operation

[POSDWI
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T [POSDWITLOG API

[POSDW/SETTINGS
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| |

Figure 15: Sequence Diagram for POSDW/SEARCH_TLOG Operation

[POSDW/
(POSDW/ CL DATA SQURCE FLAT [POSDW/
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Jposdwi/write_tlog .!_ :
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| | I |
.
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Figure 16: Sequence Diagram for /POSDW/WRITE_TLOG Operation

Enhanced Fields
Enhanced fields are not stored in the /POSDW/TLOGF table. They are populated during the transaction checks and
processing.

The only exceptions to this are the MATERIALNUMBER and the MERCHANDISECAT fields at the line item level. These
enhanced fields are stored in the database because they are required by consuming applications.

Analytic Fields

Additional fields were added to the /PosDW/TLOGF for analytic purposes and to improve the performance of the
queries built on top of the new TLOG data model.

The following table provides information about the analytic fields of the /POSDW/TLOGEF:

Table 21: /POSDW/TLOGF Analytic Fields

TRANSCOUNTER Header Fixed value (1) used for counter based
queries
BEGINDATE Header Transaction Date
BEGINTIME Header Transaction Begin Time
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CALYEAR Header Transaction Year

CALMONTH Header Transaction Month

CALDAY Header Transaction Day

CALHOUR Header Transaction Hour

CALWEEK Header Transaction Week

TAXINC ltem Amount of included taxes

TAXEXC Item Amount of excluded taxes

ITEMDISC Item Amount of item discounts

DISTDISC ltem Amount of distributed discounts from

the header level

DISTTAX ltem Amount of distributed taxes from the
header level

DISTTENDER [tem Amount of distributed tender from the
header level

DISTTAXEXC ltem Amount of distributed excluded taxes

from the header level

DISTVOID [tem Amount of distributed voids from the
header level
TASK_CANCELED Item Indicator for Canceled Task, distributed

from the header level

RETL_ITEM_CAT ltem Article category

RETL_ITEM_SCAT ltem Article subcategory

RETAILDEBITFLAG ltem Flag indicating whether the line itemis
of a debit type

Entity Relationships

In SAP POS Data Management component of SAP Customer Activity Repository, combined semantic keys are
used as primary keys.

To ensure the uniqueness of every record, a child entity inherits its primary key from its parent. It then defines an
additional field that is part of its own primary key.

Parent/child relationships are maintained using these semantic keys. Because a semantic key for a child is a
combination of its parent’s primary key and an extra field, the child primary key already contains its parent’s
primary key.

Extensibility

The extension mechanism used in SAP Customer Activity Repository is described in the Extensibility and
Extensions section.
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Structures

This following table provides information about the structures used in SAP Customer Activity Repository:

Table 22: Structures of SAP POS Data Management Component in SAP Customer Activity Repository

/POSDW/ TRANSCOUNTER /POSDW/CONSTCOUNTER | Header Analytics data fields
HEADER_ANALYTICS BEGINDATE /POSDW/BEGINDATE
BEGINTIME /POSDW/BEGINTIME
CALYEAR /POSDW/CALYEAR
CALMONTH /POSDW/CALMONTH
CALDAY /POSDW/CALDAY
CALHOUR /POSDW/CALHOUR
CALWEEK /POSDW/CALWEEK
/POSDW/ITEM_ANALYTICS | TAXINC /POSDW/TAXAMOUNT Header Analytics data fields
ITEMDISC /POSDW/
REDUCTIONAMOUNT
/POSDW/ITEM_DIST DISTDISC /POSDW/DISTDISC Item Distributed data fields
DISTTAX /POSDW/DISTTAX
DISTTENDER /POSDW/DISTTENDER
/POSDW/ INCLUDE /POSDW/ [tem line item with
ITEM_DISTRIBUTED RETAILLINEITEM_FK distribution fields
INCLUDE /POSDW/ITEM_DIST

Table Types

The following table types are used in the SAP POS Data Management component of SAP Customer Activity

Repository.

Table 23: Table Types of SAP POS Data Management Component in SAP Customer Activity Repository

/POSDW/TT_TLOGF

/POSDW/TLOGF

/POSDW/TLOGF table type

/POSDW/TT_TLOGF_EXT

/POSDW/TLOGF_EXT

/POSDW/TLOGF_EXT table type

/POSDW/TT_TLOGF_X

/POSDW/TLOGF_X

/POSDW/TLOGF_X table type

/POSDW/TT_TLOGF_CONTROL

/POSDW/TLOGF_CONTROL

Table type for control analytics

/POSDW/TT_ITEM_DISTRIBUTED

/POSDW/ITEM_DISTRIBUTED

Table of item distributed fields

/POSDW/TT_CUSTOMIZING_BUFFER

/POSDW/CUSTOMIZING_BUFFER

Customizing buffer table type
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A Reference

A.l1 The Main SAP Documentation Types

The following is an overview of the most important documentation types that you need in the various phases in
the life cycle of SAP software.

Cross-Phase Documentation
SAPterm is SAP’s terminology database. It contains SAP-specific vocabulary in over 30 languages, as well as
many glossary entries in English and German.
® Targetgroup:
©  Relevant for all target groups
® Current version:
©  On SAP Help Portal at |p help.sap.com » Glossary 2
© Inthe SAP system in transaction STERM
SAP Library is a collection of documentation for SAP software covering functions and processes.
® Targetgroup:
o Consultants
©  System administrators
©  Project teams for implementations or upgrades
® Current version:
©  On SAP Help Portal at help.sap.com (also available as documentation DVD)

The security guide describes the settings for a medium security level and offers suggestions for raising security
levels. A collective security guide is available for SAP NetWeaver. This document contains general guidelines and
suggestions. SAP applications have a security guide of their own.

® Target group:
o System administrators
o  Technology consultants
o Solution consultants

® Current version:

o On SAP Service Marketplace at service.sap.com/securityguide

Implementation

The master guide is the starting point for implementing an SAP solution. It lists the required installable units for
each business or IT scenario. It provides scenario-specific descriptions of preparation, execution, and follow-up of
an implementation. It also provides references to other documents, such as installation guides, the technical
infrastructure guide and SAP Notes.

® Targetgroup:
©  Technology consultants
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o Project teams for implementations
e Current version:
©  On SAP Service Marketplace at service.sap.com/instguides

The installation guide describes the technical implementation of an installable unit, taking into account the
combinations of operating systems and databases. It does not describe any business-related configuration.

® Target group:
©  Technology consultants
o Project teams for implementations
e Current version:
©  On SAP Service Marketplace at service.sap.com/instguides

Configuration Documentation in SAP Solution Manager — SAP Solution Manager is a life-cycle platform. One of
its main functions is the configuration of business scenarios, business processes, and implementable steps. It
contains Customizing activities, transactions, and so on, as well as documentation.

® Target group:

©  Technology consultants

o Solution consultants

o Project teams for implementations
e Current version:

o In SAP Solution Manager

The Implementation Guide (IMG) is a tool for configuring (Customizing) a single SAP system. The Customizing
activities and their documentation are structured from a functional perspective. (In order to configure a whole
system landscape from a process-oriented perspective, SAP Solution Manager, which refers to the relevant
Customizing activities in the individual SAP systems, is used.)

® Target group:

o Solution consultants

©  Project teams for implementations or upgrades
®  Current version:

o Inthe SAP menu of the SAP system under | Tools » Customizing » IMG 3

Production Operation

The technical operations manual is the starting point for operating a system that runs on SAP NetWeaver, and
precedes the application operations guides of SAP Business Suite. The manual refers users to the tools and
documentation that are needed to carry out various tasks, such as monitoring, backup/restore, master data
maintenance, transports, and tests.

® Targetgroup:
o System administrators
e Current version:
o On SAP Service Marketplace at service.sap.com/instguides

The application operations guide is used for operating an SAP application once all tasks in the technical
operations manual have been completed. It refers users to the tools and documentation that are needed to carry
out the various operations-related tasks.

® Target group:

o System administrators
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o Technology consultants
o Solution consultants
® Current version:

o On SAP Service Marketplace at service.sap.com/instguides

Upgrade

The upgrade master guide is the starting point for upgrading the business scenarios and processes of an SAP
solution. It provides scenario-specific descriptions of preparation, execution, and follow-up of an upgrade. It also
refers to other documents, such as upgrade guides and SAP Notes.

® Target group:
©  Technology consultants
©  Project teams for upgrades
® Current version:
o On SAP Service Marketplace at service.sap.com/instguides

The upgrade guide describes the technical upgrade of an installable unit, taking into account the combinations of
operating systems and databases. It does not describe any business-related configuration.

® Target group:
o Technology consultants
©  Project teams for upgrades
® Current version:
o On SAP Service Marketplace at service.sap.com/instguides

Release notes are documents that contain short descriptions of new features in a particular release or changes to
existing features since the previous release. Release notes about ABAP developments are the technical
prerequisite for generating delta and upgrade Customizing in the Implementation Guide (IMG).

® Target group:
o Consultants
o Project teams for upgrades
® Current version:
©  On SAP Service Marketplace at service.sap.com/releasenotes
o Inthe SAP menu of the SAP system under [F Help » Release Notes 3 (only ABAP developments)
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Typographic Conventions

Table 24

oome o

<Example>

Angle brackets indicate that you replace these words or characters with appropriate entries
to make entries in the system, for example, “Enter your <User Name>".

b Example » Example 3

Arrows separating the parts of a navigation path, for example, menu options

Example

Emphasized words or expressions

Example

Words or characters that you enter in the system exactly as they appear in the
documentation

Www.sap.com

Textual cross-references to an internet address

/example Quicklinks added to the internet address of a homepage to enable quick access to specific
content on the Web
123456 Hyperlink to an SAP Note, for example, SAP Note 123456
Example e  Words or characters quoted from the screen. These include field labels, screen titles,
pushbutton labels, menu names, and menu options.
® (Cross-references to other documentation or published works
Example ®  Qutput onthe screen following a user action, for example, messages
®  Source code or syntax quoted directly from a program
® File and directory names and their paths, names of variables and parameters, and
names of installation, upgrade, and database tools
EXAMPLE Technical names of system objects. These include report names, program names,

transaction codes, database table names, and key concepts of a programming language
when they are surrounded by body text, for example, SELECT and INCLUDE

EXAMPLE Keys on the keyboard
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No part of this publication may be reproduced or transmitted in any
form or for any purpose without the express permission of SAP SE
or an SAP affiliate company.

SAP and other SAP products and services mentioned herein as well
as their respective logos are trademarks or registered trademarks
of SAP SE (or an SAP affiliate company) in Germany and other
countries. Please see www.sap.com/corporate-en/legal/copyright/
index.epx#trademark for additional trademark information and
notices.

Some software products marketed by SAP SE and its distributors
contain proprietary software components of other software
vendors. National product specifications may vary.

These materials are provided by SAP SE or an SAP affiliate company
for informational purposes only, without representation or warranty
of any kind, and SAP SE or its affiliated companies shall not be liable =
for errors or omissions with respect to the materials. The only

warranties for SAP SE or SAP affiliate company products and

services are those that are set forth in the express warranty

statements accompanying such products and services, if any.

Nothing herein should be construed as constituting an additional
warranty.

In particular, SAP SE or its affiliated companies have no obligation to
pursue any course of business outlined in this document or any "
related presentation, or to develop or release any functionality "
mentioned therein. This document, or any related presentation, and
SAP SE's or its affiliated companies' strategy and possible future
developments, products, and/or platform directions and
functionality are all subject to change and may be changed by SAP
SE or its affiliated companies at any time for any reason without
notice. The information in this document is not a commitment,
promise, or legal obligation to deliver any material, code, or
functionality. All forward-looking statements are subject to various
risks and uncertainties that could cause actual results to differ
materially from expectations. Readers are cautioned not to place
undue reliance on these forward-looking statements, which speak
only as of their dates, and they should not be relied upon in making
purchasing decisions.
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